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Preface

What is an instrument driver?

1 Preface

The aim of this paper is to provide information regarding Rohde & Schwarz (R&S)
instrument drivers. This paper shall help application engineers, as well as software
developers to easily get an understanding of advanced techniques to develop test and
measurement (T&M) application by utilizing R&S instrument drivers. Furthermore the
used nomenclature for R&S instrument drivers will be explained.

It does not describe any programming languages nor, how to develop software in any
programming language.

Microsoft® and Windows® are U.S. registered trademarks of Microsoft Corporation.

National Instrument®, LabVIEW®, LabWindows/CVI® are U.S. registered trademarks of
National Instrument.

MATLAB® is a trademark of The MathWorks, Inc.

Rohde & Schwarz® is a registered trademark of Rohde & Schwarz GmbH & Co. KG.
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Frequently Asked Questions (FAQ)

What is an instrument driver?

2 Frequently Asked Questions (FAQ)

2.1 What is an instrument driver?

An instrument driver, in the context of T&M application development, is a set of
software routines, which simplify the remote control of your measurement instrument.
Through the input and output (1/O) abstraction via hiding the SCPI' commands a much
more easier way of programming is possible. As buzzword command completion2 of
integrated development environments (IDE) can be mentioned. This feature is not
available for SCPI commands.

R&S instrument drivers are based on Virtual Instrument Software Architecture (VISA3)
which enables an physical independent connection between the host PC and the
instrument.

Generally instrument drivers allow greater system flexibility and accelerate
development time for instance by the possibility of reusing software. Major advantage
is the reduction of the development time for any kind T&M application due to the fact of
using a high level programming language in contrast to implement an application with
SCPI commands. For instance all string formatting which is necessary when using
SCPI commands is already done by the instrument driver.

2.2 Why should | use an instrument driver instead of

SCPI commands?

Writing an application can take a lot of time. But writing the application is not the end of
the story, since the T&M instrument must also be driven. That is not so simple with
complex equipment, since just the description of the command set may comprise
several hundred pages. Applying yourself to this task can be time consuming. Which is
why Rohde & Schwarz provides ready-to-use software instrument drivers, relieving
designers of these efforts to great extent. It is no longer necessary to search through
manuals looking for commands; this has already be done when developing the
instrument driver.

' Standard Commands for Programmable Instruments (SCPI) is a command set for
remote controlling T&M instruments. Further information is available on
http://www.scpiconsortium.org/

2 "Command completion” of current integrated development environments offers the
g)ossibility to safe time and avoid typing errors during programming (e.g. in C++ or C#)
Virtual Instrument Software Architecture (VISA) as Host PC software a well defined
hardware abstraction layer and 1/0O programming interface for various interfaces (e.g.

General Purpose Interface Bus (GPIB) or Ethernet)

1MA153_1e
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Frequently Asked Questions (FAQ)

Why should | use an instrument driver instead of SCPI commands?

Drawbacks of programming with SCPI commands:

For simple applications like setting frequency/RF level and reading out simple
measurement values (e.g. for digital mulitmeters) SCPI programming can be sufficient.
However for more sophisticated applications this approach reaches quite fast its limits.

Example: Simple spectrum analysis

Even for simple spectrum analysis it starts to be quite complicated and error prone
using SCPI commands. For instance, all data formatting of a read out data stream has
to be done manually when using SCPI commands. This formatting is already done by
the instrument driver, so it is possible to easily process the read out data within the
T&M application.

As one can imagine, for more complex T&M application, like mobile standard
generation (e.g. for Wideband Code Division Multiple Access (WCDMA) Signals) or its
measurement, using SCPI commands is quite time consuming. Therefore setting up
your instrumentation using instrument drivers avoids a lot of string formatting and other
data parsing. Moreover the local grouping of functions within the provided compressed
HTML help file (chm file) offers you all configuration possibilities at a glance.

Development, maintenance and software reuse

Instrument drivers speed up your application development process. This can be
achieved due to the fact that debugging and error diagnostics is well supported by the
instrument driver. So it is possible to easily get rid of wrong configurations as well as
not understood commands. This is done by extensively using the instruments error
reporting functionality. For further details please have a look in chapter 4.

During the lifetime of T&M applications requirements can change, also for this reason
instrument drivers can help you modifying a application. The logical grouping of your
instruments functionality allows one easily to extend or modify your application on a
abstract and logical level.

The described pros to simplify your T&M task is also a reason why reuse of already
written software can be realised. Due to the concept of instrument family drivers,
software written for research and development reasons on a high end instrument like
the Vector Signal Generator R&S SMU200A can easily be reused for production lines
which are equipped with e.g. the mid-range Vector Signal Generator R&S SMBV100A.
The instrument driver abstracts the instrument, so this software can often be reused
without any changes. Of cause the functionality needs to be supported on both
instruments.

1MA153_1e Rohde & Schwarz Development Hints and Best Practices for Using Instrument Drivers 6



Frequently Asked Questions (FAQ)

VISA and physical interfaces

2.3 VISA and physical interfaces

All R&S instrument drivers use VISA to avoid an individual driver for every different
device interface. The VISA /O software is generally a application programming
interface (API) providing an input and output low level AP| to communicate with
measurement instruments. This standard was defined by the VXIplug&play (VXIPnP)
Systems Alliance, with National Instruments and others, being represented in the
consortium.

These 1/O functions are independent of the used device interface.

An initialization string (so called VISA resource locater) in the relevant application
program defines which device interface (GPIB, RS-232, LAN, USB) to use. The
subsequent program routine is completely independent of the used interface.

All Rohde & Schwarz instrument drivers requires at least National Instruments VISA
(NI-VISA) revision 3.0 or higher. For Linux it is strongly recommended to use the latest
version of NI-VISA. Also the usage of Agilent I/O Library Suite* is possible.

2.4 What are attribute based instrument drivers?

The concept of attribute based drivers is that nearly every SCPI command is
accessible via an attribute. Its modularity and the possibility to access almost every
instrument property via attributes enables a very sophisticated way of T&M application
programming.

Attribute based drivers can easily be indentified: All attribute based instrument drivers
has an additional Driver Attribute Help file (rsXXX_attr.chm) within the drivers
installation directory.

For using attributes to write more flexible application, please see chapter 4.5 and
chapter 4.6 for further explanation.

It is important to realize that not every R&S instrument drivers is an attribute based
driver.

* For further information please visit http://www.agilent.com
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Frequently Asked Questions (FAQ)

What is the RsSpecAn instrument driver?

2.5 What is the RsSpecAn instrument driver?

The new generation of R&S attribute based spectrum analyzer instrument drivers
(RsSpecAn) gives great flexibility and ease of use by combining low-level access to
nearly every SCPI command via attribute and well balanced high level functions and
Vls, combining several attributes. For those who don't want to learn new attribute
concept, complete functionality of instrument is covered by high level commands. In
other words, you may use attributes, but you don't have to. Of course it is possible to
combine both low level attributes and high level functions together exactly according to
needs of every specific application.

Comparing to older family instrument drivers (so called legacy drivers), the source
code of both LabWindows/CVI and LabVIEW RsSpecAn instrument drivers are divided
into modules/folders according to personalities. This gives opportunity to easily get rid
of non-used functions and Vis.

2.6 Are R&S instrument drivers compatible with the
VXIPnP driver standard?

Yes. For further information please have a look into the readme.txt in side your
instrument driver's installation directory.

2.7 Where to find the VXIPnP installation directory?

This path is defined via an environment variable on your operating system, which can
be read out in the environment variable "VXIPNPPATH".

For Windows based operating systems, this variable can easily read out via Windows
command prompt using the command "set".

Note: With NI-VISA Version 4.2 the default installation path changed from C:\VXIPNP
to C:\Program Files\IVI Foundation\VISA.

2.8 How to install R&S instrument drivers on Windows?

For installation hints please use the driver specific "How to use...", which can be
downloaded at the instrument's driver download page:

http://www2.rohde-schwarz.com/en/service _and support/Downloads/Drivers

1MA153_1e Rohde & Schwarz Development Hints and Best Practices for Using Instrument Drivers 8
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Frequently Asked Questions (FAQ)

How to install R&S instrument drivers on Windows?

Further specific steps and hints for installing instrument driver are available on the
driver download site available at the product internet site.
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Best practice for software development

Getting started

3 Best practice for software development

3.1 Getting started

To get started please download one of the provided application examples from the
driver download site

http://www2.rohde-schwarz.com/en/service_and support/Downloads/Drivers/

to get an idea of how a remote control application can look like.

It is recommended to use the provided instrument driver compressed HTML help files
(chm files) for getting started.

3.2 How to start to develop my own application?

To getting started it is applicable to use the Instruments Driver Help (rsXXX[_vxi].chm)
file inside your instruments driver's installation directory in combination with our
instruments operating manual remote control command chapter.

A good approach is to use the provided application examples as skeleton for new
applications.

The easiest way to find the proper driver function call is to find the SCPI command (in
the long version) inside the instrument operating manual and look for the command
inside the Instrument Driver Help file using the index or search functionality.

For developing more complex applications it is practical to identify the manual
operation steps and utilize the "Instrument Drivers Tree Structure" to find your driver
function calls for the manual configuration steps in this logical structure.

Which information can be found inside the Instrument Driver Help, also Attribute Driver

Help (rsXXX[_vxi].chm)):

e Mapping of SCPI command and driver calls (and vice versa) via the search and
index functionality

e Grouped driver functions to easily identify all functions for a certain 3GPP standard
(Instrument Driver Tree Structure)

e Possibility to include instrument help to search for instrument and driver
functionality at one time (Please note: this is not in available in every driver)

e For attribute based drivers (with rsXXX_attr.chm): Mapping of attributes and driver
calls (see figure below)
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Best practice for software development

What is the purpose of the "Driver Attribute Help"?

4 &S Spectrum Analyzers [ -
E? R&S Spectrum Anal ¥i O] x

Ausblenden  Zunick Drucken  Optionen

|»

Inhalt ||ﬂl:|E:-: | ﬁuchenl

2] Welcome
2] Wwihy Instument Dirivers? ROHDE & SCHWARZ

E Supported Environments
E Supported Instruments
E Supported Interfaces

Welcome to rsspecan Attaibutes help

2] What's Mew? This help system is intended to provide you with all
2] Getting started and Examples the infarmation that is necessary for remate contral
@ Irstrument Driver Tree Stucture of the R&S device wia attribute based instrument
2] 2lphabetical list of functions driver. Please use the navigation tools to the left or
2] Cortact directly access the main chapters:
2] How b use this help
= () Driver Attribute Help @ Attributes tree structure
[7] Wwelcome
@ Attribute Tree Stucture @ Alphabetical list of attributes
(2] Aphabetical list of functions @ Install and how to use this help
[2] How to uze thiz help
FSL Instiument's Operating Manual Trade names are trademarnks of the owners
ESL Instrument's Operating Manual
F5W Instrument's Operating b anual Copyright () 2009 Rohde & Schwarz GmbH & Co. K T
Last updated: 18252009 2:17:37 P ;I

Figure 1: Mapping of attributes and driver calls within the Driver Attribute Help.
For more information about the "Driver Attribute Help" please see chapter 3.4.

Note: This feature is not available in all R&S instrument drivers.

3.3 What is the purpose of the "Driver Attribute Help"?

For sophisticated programming the "Driver Attribute Help" as a chapter of the driver
help file can help to identify instruments attributes. These low level configuration can
be used to set or get instrument properties, which are normally encapsulated in high
level driver functions. For some reasons this attributes need to be set or read out
independently via get or set attribute functions.

How to use attributes is described in chapter 4.5 and chapter 4.6.
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Best practice for software development

How to combine instrument manuals and the driver's compressed help files?

3.4 How to combine instrument manuals and the

driver's compressed help files?

There is the possibility to include the "Instrument Operating Manual" inside the
"Instrument Driver Help".

Please follow the instructions in the last chapter of your "Instrument Driver Help" file.
See for instance the RsSpecAn help in the figure below:

=101
S I

Ausblenden  Zuriick Drucken  Optionen

=]
Inhak ||ﬂde” l EUCthI This section contains the Operating Manual of the instrument. Faor
9 welcome proper operation all CHM help files rmust be placed in the same
z W [nstrument Drivers? falder. _
2] Supparted Ervitanments Tao download the Compressed Operating Manuals for Spectrum
E Supparted Instrurments Analyzer Mode go ta:
2] Supparted Interfaces http: fevvew rohde-schwarz comddownloads/helpdfsl html

z What's Rew?

E Getting started and Examples

@ Instrument Driver Tree Stucture
(2] Aphabetical list of functions

2] Contact

E How to uze this help

@ Driver Attribute Help

ﬂ F5SL Inztrument's O perating b anual
ﬂ ESL Instument's Operating kM anual
E FSY Instrument's Operating M anual

Figure 2: Where to download and include the Instruments Operating Manual.
Depending on your Windows operating system, it can be necessary to open the

instruments operating manual once, to mark the file as trustworthy for the operating
system.

Note: This feature is not available in all R&S instrument drivers.

3.5 How to integrate R&S instrument drivers into

Microsoft Visual Studio 200x

The following examples are referring to the RsSpecAn instrument driver. The
described procedures are all adaptable to other R&S instrument drivers, only the
naming of the files can be different. The naming convention is rsXXX, where XXX is
the abbreviation of the instrument's (-family) driver.
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Best practice for software development

How to integrate R&S instrument drivers into Microsoft Visual Studio 200x
3.5.1 C# and instrument drivers: How to get started?

A wrapper is necessary to enable a direct access to the driver dynamic linked library
(dll). This wrapper is automatically installed in the ~VXIPnP\WinNT\include directory,
where VXIPNPPATH is your VXIPnP environment variable pointing to your VXIPnP
installation directory.

How to create a new T&M application project in Microsoft Visual Studio 200x:

Create a new project, e.g. File -> New -> Project.

File | Edit WView ClearCase Tools Window  Community  Help

New [T progect... ctrlsshiftth |

Open b '@ Web Site..,

Close [ File... Chrl+M
Project From Existing Code...

@ savenl Chrshife+S Visual Studio Devel

The current news «
connection might |
on the Tools menu
click Startup.

Recent Files 3
Recent Projects 13

Exit

leh Sike:, .

Figure 3: Create a new project in Visual Studio

Select your programming language and your template type, e.g. Visual C# Windows
Application, or Console Application.

New Project [2]x]
Project types: Templates: EE
[=- Visual C# Visual Studio installed templates
P e Windows
Y cation I;Ec\ass Library
(@vindows Cantrol Library (&b Contral Library
i G Starter Kits ® Cansols Application Jgwindaws Servics
Other Languages [ Empty Praject [E#]Crystal Reports Application

[#- Other Project Types
My Templates

“flsearch Online Templates. .

Figure 4: Select your desired template

To access the instrument driver, it is necessary to include the provided VXIPnP
wrapper for C#, e.g. Project->Add Existing Item...
~VXIPnP\WinNT\include\rsspecan.cs

Also the drivers namespace has to be included to the current source code file for

example via the directive "using InstrumentDrivers". The result is shown in the picture
below:
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3.5.2

How to integrate R&S instrument drivers into Microsoft Visual Studio 200x

2% WindowsApplication1 - Microsoft Yisual Studio Hi=] I
File Edit ‘“iew Refactor Project Buld Debug ClearCase Data  Tools  Window  Community  Help
A-E- S @ % LR E b Dby -y "y
DR |EE =2 0P8 8885 A,
p Forml.cs*| Program.cs | Forml.cs [Design]* | Start Page | L Q] Solution Explorer - ... ~ & X
Q_‘ IV‘EgWindowsﬁ\pplicationl.Forml jl wFormli) j = |=-';l':I g = E =
g 4| using System.Data: ;Solution 'Windows.ﬂpplicaﬂ
- . . .
5| nusing System.Drawing: B- E t""“dUWSﬂ.IJIJhCath
5| using System.Text: =l Properties
] ] g] References
7 using System.Windows.Forms: =
5 T — EForml.cs
= = =TT ment e 1
using InstrumentDriv &) Program.cs
| Cﬁ rSSpECAn.CS
105 namwespace Tindowshipplicationl
11 ¢

Figure 5: Include the RsSpecAn driver to your current project.

Now the development environment is configured in a proper way. For getting started
your application development, please have a look at the provided examples on your

instrument's driver download site:

http://www2.rohde-schwarz.com/en/service_and support/Downloads/Drivers/.

VB.NET and instrument drivers: How to get started?

A wrapper is necessary to enable a direct access to the driver dynamic linked library
(dll). This wrapper is automatically installed in the ~VXIPnP\WinNT\include directory,
where VXIPNPPATH is your VXIPnP environment variable pointing to your VXIPnP

installation directory.

How to create a new T&M application project in Microsoft Visual Studio 200x:

Create a new project, e.g. File -> New -> Project

Filz | Edit  Miew ClearCase

Toals

Windaou

Community  Help

New

»

| [Ea]

Project...

Open

Clase

@ saveal

CrrH+Shife+5

Recent Files
Recent Projects

Exit

»

Chrl+shift+h |

o ‘wehsie...

1 File..

Project From Existing Code...

leb Site,

visual Studio Devel

The current news «
connection might |
on the Tools menu
click Startup.

ChrM

Figure 6: Create a new project in Visual Studio

Select your programming language and your template type, e.g. Visual C# Windows
Application, or Console Application.
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How to integrate R&S instrument drivers into Microsoft Visual Studio 200x

oo F
Project types: Templates: 88 o
El- Visual C+H+ || visual Studio installed templates
- Labiindows YT
- aTL EE Windows Application gﬂ Class Library
- LR, g Console Application :@ Windows Control Library
- zeneral ‘:@ Web Control Library dﬂ Windows Service
- MFC (%] Empty Project )ECrystaI Reports Application
- amark Device
- WinS2 My Templates
[=1- Other Languages
= Wisual Basic [ 3earch Online Templates...
L Windaws
Smark Device
Dakabase e
Starker Kits
Lweh
Tl Wicial LI

Figure 7: Select your desired template

Also the drivers namespace has to be included to the current source code file via the
directive "Imports WindowsApplicationl.rsspecan" (where rsspecan can be seen as
example driver). The result is shown in the picture below:

Solution Explorer - Solution*... -~ & X rsspecan.vb /Form1.wb* |~ Forml.vb [Design]* | Start Page | Object Brow
52| EE S Id;:j(ﬁeneral)
: Salution “WindowsApplicationt’ (1 p (¥ 1rports Windowsipplicationl.rsspecan
= 5@ WindowsAapplication1 3
o [l My Project sgPublic Class Formil
i =] Form1.vhb 4
i TE] rsspecan.vh -
&
7 LEnd Class
=]

Figure 8: Include the RsSpecAn driver to your current project.
Now the development environment is configured in a proper way. For getting started
your application development, please have a look at the provided examples on your
instrument's driver download site:

http://www2.rohde-schwarz.com/en/service_and support/Downloads/Drivers/.

3.5.3 C++ and instrument drivers: General hints

Problem: The header file rsXXX.h was not found while compiling

Solution: Please set your VXIPnP include directory in your Visual Studio Project
properties (see picture below). Your include directory is the
SVXIPNPPATH$\WinNT\include, where VXIPNPPATH is your VXIPnP environment
variable pointing to your VXIPnP installation directory.
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How to integrate R&S instrument drivers into Microsoft Visual Studio 200x

Configuration: IActive(Dehug) j PlatForm: IActive(Win32) j Configuration Manager. ., I
- Common Properties Additional Ind ) CHYXIPNP WinNT  include ._l
E| Configuration Properties Resolve #using References

- General Debug Information Farmat Program Database for Edit & Continue {/2I)
- Debuaging Suppress Skarkup Banner Yes {fnologo)
B0+ arning Lewvel Level 3 (/W3)
~General Detect 54-bit Portability Issues Mo
-~ Optimization Treat \Warnings As Errors ko
- Preprocessor X Use UNICODE Response Files Yes
- Code Generation
- Language
- Precompiled Headers
- Outpuk Files
- Browse Information
- Advanced
- Command Line
- Linker
[#]- Manifest Toal
[+-Resources
[+ ¥ML Docurient Generakor
[~ Browese Information
[#-Build Events
[ Custom Build Step
Additional Include Directories
Specifies one or more directories to add to the include path; use semi-colon delimited list if more than one.
{fI[path])

K I Abbrechen  Ubernehmen

Figure 9: C++ Compiler settings for instrument driver header files.

Problem: Linker error while building your software project.

Solution: Please specify your VXIPnP libraries in your Visual Studio Project properties
(see picture below). Your specific library rsXXX.lib can be found in
SVXIPNPPATHS$\WinNT\library\msc, where VXIPNPPATH is your VXIPnP
environment variable pointing to your VXIPnP installation directory.

Configuration: IP.ctive(Debug) j PlatForm: IActive(Win32) j Configuration Manager .., |
[=- Configuration Properties ;I Additional Dependencies rsetllib visa3z.lib| _I
- General Ignore All Default Libraries Mo
- Diebugging Ignore Specific Library
B CIC+H+ Module Definitian File
- General Add Maodule to Assembly
- Optimization Embed Managed Resource File
- Preprocessar _ Farce Symbal References
Eode seneration Delay Loaded DLLs
P?;E;:E;Ted Headers Assembly Link Resource
- Qkput Files
- Browese Information
- Advanced
- Command Line
- Linker
- General
- Impuk
- Manifest Fils
- Debugging ]
- Systern
- Opkirization
- Embedded IDL
- Advanced Additional Dependencies
. Command Line - Specifies additional items to add ta the link line {ex: kernel32.lib); configuration specific.
u o™

o, I Abbrechen  Ubernehimen

Figure 10: C++ Linker settings for instrument driver libraries.
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How to integrate R&S instrument drivers into Microsoft Visual Studio 200x

Problem: The library rsXXX.lib was not found while building your software
project.
Solution: Please set your VXIPnP library path in your Visual Studio Project properties
(see picture below). Your library directory is the $YXIPNPPATH$\WinNT\library\msc,
where VXIPNPPATH is your VXIPnP environment variable pointing to your VXIPnP

installation directory.

Configuration: IActive(Debug)

j Platform: IActive(Win32)

=

Configuration Manager., .. |

1]

[=- Configuration Properties ;I

- General

- Debugaing

= CiC++

- General

- Opkimization

- Preprocessor

- Code Generation

- Language

- Precompiled Headers
- Oukput Files

- Browse Information
- fdvanced

- Command Line

[=1- Linker

- General

- Impuk

- Manifest File

- Debugging —
- Sysbem

- Opkimization

- Embedded IDL

- fdvanced

- Command Line -
| x|

Qukput File $(OUEDir $iProjectiame). exe

Shaow Progress Mok Set

Yersion

Enable Incremental Linking Yes {/INCREMENTAL)

Suppress Skartup Banner Yes [fMOLOGO)

Ignare Impart Library Mo

Reqister Outpuk Mo

Per-user Redirection ]

Additional Library Directories 2\ WXIPNP, WInNT " lib',msc| ._I

Link Library Dependencies es

Use Library Dependency Inputs Mo

Use UNICODE Response Files Yes
Additional Library Directories
Specifies one or more additional paths ko search For libraries; configuration specific; use semi-colon
delimited list if more tham one.,  (fLIBPATH:[dir])

K I Abbrechen  Ubermehmen

Figure 11: C++ Linker settings for instrument driver libraries.

Problem: The Instrument was not found and VISA resource string in NI-Spy has
only the size of one character.
Solution: Correct your character settings in your Visual Studio Project properties (see
picture below).
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How to integrate R&S instrument drivers into Microsoft Visual Studio 200x

Configuration: Iﬁctive(Debug)

j Platform: IActive(WinSZ) j Configuration Manager ...

[+ Common Properties

E| Configuration Properties
- General

- Debugging

CiC+H+

Linker

Manifest Toal
Resources

*¥ML Docurment Genetratar
Browse Information
Build Events

- Custom Build Step

[ W O e B e O e B e O

B General
Dukput Direckory
Intermediate Directory
Extensions to Delete on Clean

${SolutionDir)${ConfigurationName)
${ConfigurationName)
* . abjy*.ilky® . blby ¥ i ¥ kR * eepg . rspy®. pacy* . pad; ¥ rekagy

EBuild Log File F(IntDir ) BuildLog. htm
Inherited Project Property Sheets
Enable Managed Incremental Build Wes

E Project Defaults
Configuration Type Application {.exe)
Use aof MFC Use MFC in a Shared DLL
Use of ATL Mok Using ATL
3 Use Multi-Byte Characker Set ;I
Comman Language Runtime suppott Mot Set
whale Pragram Optimization

Char:

Use Unicode Character Set

Character Set
Tells the compiler ko use the specified character set; aids in localization issues.

4 Abbrechen  Ubernefimen

Figure 12: Correct character settings for Visual Studio 2009

3.5.4 C++ and SCPI commands: How to get started?

This chapter shall help developers to set up their development environment to easily
getting started without using instrument drivers.

After creating a new project, it is important to enable your development environment's
linker to access the VISA library. The figures below are showing a possible
configuration. Note that this depends on your host PC VXIPnP installation.
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TEMPLATE Property Pages

How to integrate R&S instrument drivers into Microsoft Visual Studio 200x

Configurakion: IF\Ctive(Debug)

ﬂ Platfarm: IActive(Win32)

j Configuration Manager. .. |

[# Cormman Properties

E| Configuration Properties
- General

- Debugging

- CIC+H+

[=1- Linker

[+ Manifest Tool

[+ ®ML Docurment Generator
[+ Browse Information

[+]- Build Events

[+ Custom Build Step

[+ Web Deplayment

Cukput File

Shaw Progress

Wersion

Enable Incremental Linking
Suppress Skartup Banner
Ignore Import Library
Register Output

Additional Library Directories
Link Library Dependencies
Use Library Dependency Inputs
Use UNICODE Response Files

F(CutDir) ${ProjectMame). exe
Mok Set

Yes {/INCREMENTAL)

Yes ([NOLOGO)

Mo

Mo

C: WXIPNP', WInNT lib'msc
Es

Mo

es

Output File
Override the default output File name.

(YoUT:[File])

o4 I Abbrechen  Ubernehimen
Figure 13: Setting up the "Additional Library Directory"
TEMPLATE Property Pages EHE
Configuration: Inctive(Debug) j PlatFarm: IActive(WinSZ) j Configuration Manager. .. |
[+ Comman Properties = Additional Dependencies visa3zlib
[=- Configuration Properties Ignare all Defaulk Librarias Mo
- eneral Ignare Specific Library
- Debugging Module Definition File
B CIC+H+ Add Module ko Assembly
Gen.er.al _ Ermbed Managed Resource File
-+ Optimization Force Symbal References
-~ Preprocessar ) Delay Loaded DLLs
- Code Generation o
Assembly Link Resource
- Language
- Precompiled Header s
- Qukput Files
- Browse Information
- fdwanced
- Command Line
- Linker
- General
- Manifest Fil
- Debugging
- Syskem
- Opkirization
- Embedded I0L Additional Dependencies
- Bidvanced - Specifies additional items to add to the link line {ex: kernel32.lib); configuration specific.
<| o™

Ubernehmen

074 I Abbrechen

Figure 14: Setting up linker parameter "Additional Dependencies"
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General programming hints

How to disable option checking?

4 General programming hints

The following is referring to the RsSpecAn instrument driver. The described
procedures are all adaptable to other R&S instrument drivers, only the naming of the
files can be different. The naming convention is rsXXX, where XXX is the abbreviation
of the instrument's (-family) driver.

4.1 How to disable option checking?

In the LabWindows/CVI instrument driver the command is called:

€.g. rsXXX_setCheckOption(ViSession instrumentHandle,
ViBoolean optionChecking);

In the LabVIEW instrument driver the command is called:
€.g. rsXXX Option Checking.vi

Where XXX is instrument driver specific. Please note that this function is not available
in all instrument drivers.

Note: Inside the folder "Instrument Driver Tree Structure->Utilities" of the instrument
driver's chm help file you can check, whether the command is available.

4.2 How to disable error/status checking?

In the LabWindows/CVI instrument driver the command is called:

€.g. rsXXX _setCheckStatus (ViSession instrumentHandle, ViBoolean state);
In the LabVIEW instrument driver the command is called:

€.g. rsXXX Instrument Status Checking.vi

Where XXX is instrument driver specific. Please note that this function is not available
in all instrument drivers.

Note: Inside the folder "Instrument Driver Tree Structure->Utilities" of the instrument
driver's chm help file you can check, whether the command is available.
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How to disable range checking?

4.3 How to disable range checking?

While initializing a driver session, the range checking functionality can be disabled
using an option string. Further details can be found inside the driver instrument chm
help file.

Instead of using the rsxxX_Init (.) function to initialize a driver session a second
function is available. In the LabWindows/CVI instrument driver the function is called:

€.g. rsXXX_InitWithOptions (ViRsrc resourceName, ViBoolean idQuery, ViBoolean
resetDevice, ViString optionString, ViSession* instrumentHandle);

Where XXX is instrument driver specific.

In the LabVIEW instrument driver the express VI rsspecan_core_attribute_express
Source.vi can be used to set the attribute RS_ATTR_RANGE_CHECK. How to modify
attributes in LabVIEW is described in chapter 4.5.

Note: Inside the folder "Instrument Driver Tree Structure->Utilities" of the instrument
driver's chm help file you can check, whether the command is available. This function
is not available in all instrument drivers.

4.4 How to speed up the driver execution?

In normal operation mode a status check is preformed after every command. It is
strongly recommend to utilize this functionality to identify errors fast and reliable.

For improving execution time in many drivers it is possible to disable error status
checking. To do so, please disable error/status checking, see chapter 4.2 for details.

45 How to use attributes in LabVIEW?

The following example is referring to the RsSpecAn instrument driver. The described
procedures are all adaptable to other attribute based R&S instrument drivers, only the
naming of the files can be different. The naming convention is rsXXX, where XXX is
the abbreviation of the instrument's (-family) driver.

This chapter shows how to use attributes in the RsSpecAn driver. This feature is useful
for sophisticated instrument control.

Please also use the Driver Attribute Help chm file. This help file is accessible via the
Instruments Driver Help (rsXXX[_vxi].chm).
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How to use attributes in LabVIEW?

Example: How to set the Frequency Start value by attributes

To select an attribute use the provided Express VI, included in instrument driver
package. This instrument driver Express VI can be found in:
User Libraries => Express User Libraries => rsspecan

Function ]
(4, search | 32 view | ZF
| Programming

||+ Measurement Ijo

|| > Instrument IjO

|l'» vision and Motion

[ > Mathematics

|'» signal Frocessing

-

|'» Data Communication

||+ Conmectivity

|+ Control Design & Simulatic

|'» signalExpress

|'» Express
|y addans

|['» Favorites

|| w User Libraries

L Express User Libraries
L

FESpECAn

| selectawv... LI

Figure 15: Palette Menu of RsSpecAn driver

Drag and drop the rsspecan Attribute in your block diagram. After placing the express
VI the front panel of the Express VI will be opened (see Figure below).

=
Select Attribute Attribute ID
Attribute Help
----- Markers
e St This class contains the attribute that configure
B System aption FSP-B6 - T4 Trigaer. =
=t Reference Oscillatar
o Trigger (13 Trigger RF Power Level:
- External Mixer This attribute sets the level of the RF power
B Amplitude trigger source,
B Limnik Lines (2 T% and RFP Trigger Source:
[ Display Contral This attribute selects the trigger source for the
F- Hard Copy | start of a sweep.
..... Fil

= e . (33 TV Trigger Free Run Mode:
s Service This attribute activates or deactivates the free
[ Measurement run krigger mode.
[ Receiver . . )
[ B10 - External Generator Contral FI_‘L) T\n't;I'r_ngter \u'etrtlctal S'tg'_“al: . -
- B27 - FM Demodulation Analog S)"IlﬂscasigrllﬁaLll 1 I TN 1 47l T
[ B71 - Analog Baseband Input i
[}~ B17 - Digital Baseband Input (53 TV Trigger Line System:
F K5 - GSMJEDGE This attribute defines the line system in use (525
B} K7 - FM Demodulator - or 625 lines) with active TV trigger.
<| T | I _>|_I (&) T¥ Trigger Horizontal Sync Signal: ;I
Attribute Operation Repeated Capabilities
[Read | |

OF I Cancel | Help |

Figure 16: Front panel of rsspecan_core_attribute_express Source.vi
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How to use attributes in LabVIEW?

Now you can select the desired attribute from tree structured list. Each attribute can
has a different access type (read only, write only or read/write). Proper read/write
operation can be selected by "Attribute Operation" in the bottom left corner.

Repeated capabilities are set by using a string control at the bottom of the panel called
"Repeated Capabilities". The attribute value is entered using standard LabVIEW
controls for each data type (numeric, boolean, string or ring).

For example use in Basic Operation "Set Frequency Start" value:

) Configure rsspeca ll

Select Attribute Attribute ID
«|[RSsPECAM_ATTR_FREGUEMCY_START
[}, Basic Operation Attribute Help
e Amplitude Units

Specifies the left edge of the frequency domain ;I
Atenuation in Hertz, This is used in conjunction with the

- Attenuation Auto RSSPECAN_ATTR_FREQUENCY_STOP Stop
attribute ta define the frequency domain. IF the
RSSPECAN_ATTR_FREQUEMCY_START attribute
walue is equal to the
RSSPECAM_ATTR_FREQUEMCY_STOF attribute

- Center Frequency value then the spectrum analyzers horizontal

- Cenker Frequency Step attributes are in time-dormain.

- Cenker Frequency Step Auto

- Center Frequency Coupling

- Cenker Frequency Coupling Fackar
- Frequency Span Remote-conktrol command(s):

- Full Frequency Span [SEMSe <1|2>]:FREQuency :STARE
- Frequency Mode

- Input Impedance

- Mumber of Sweeps

- Reference Level

- Reference Level Offset

-~ Frequency Stop
Frequency Offset

Available Repeated Capabilities:
Window: Wind,\Winl, Win2

Resolution Bandwidth -
. Seseen Banae _>l_| -
Attribute Operation Repeated Capabilities  Yalue
[iwrice = JJI1E+o

[o]'4 I Cancel | Help |

Figure 17: Configure "Set Frequency Start" example

1. Select the desired attribute. To find the designated attribute easily the

rsspecan.chm help file can be used to look for it. Be aware of the fact that the tree

structures in the help file and the Express VI are the same

Leave "Repeated Capabilities" empty

Type the desired frequency value in the text box "Value"

4. After clicking the "OK" button, a new instance attributed based VI is generated.
The name of the VI and its predefined values and also the help will be adapted.

w N

The result is shown in following figure.
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B
Set Frequency Start ) ;I
Erecen)
Input: Double

Set Frequency
Start ()
instrument handle -~ Jrinstrument handle

aAttribute I~ Atbribute ID

Repeated Capabilities ~~Repeated Capabil
Brror in {no error) =={rerror in (o error)

instrument handler= instrument handle out

error out *f==error ouk

S

Set Frequency
Start ()

rinstrument handle

b Attribobe 10

*Fepeated Capabil

FEFFOF N (Na error

instrument handle )

efror out L

Figure 18: Instanced attribute based VI "Set Frequency Start"

This Express ¥1is configured as Follows:

Attribute 1D RSSPECAN_ATTR _FREQUENCY_START
Repeated Capabilities:
Attribute Yalue: 1E+9

Specifies the left edge of the frequency domain in Hertz. This is used
in conjunction with the RSSPECAN_ATTR_FREQUENCY_STOP Stop
attribute ko define the frequency domain, IF the
RSSPECAN_ATTR_FREQIUENCY_START attribute value is equal ta the
RSSPECAM_ATTR_FREQUEMNCY STOP atbribute value then the
spectrum analyzers horizontal attributes are in time-domain.

Awvailable Repeated Capabilities:
wwindow: Win0,Winl,Win2

Remote-control command(s):
[SEMSe<1|2:>]:FREGuency: STARE

4.5.1 Repeated capabilities

How to use attributes in LabVIEW?

Many measurement instruments have capabilities which are duplicated. For example,
an oscilloscope might have several channels with identical functionality or a power
supply may have several outputs. For this reason repeated capabilities are introduced.

Repeated capability instances are specified by a string parameter for each property. It
also can be specified by a function which selects the active instance.

To define the usage of particular capability fill the text box "Repeated Capability" in the
front panel of the Express VI with the proper value. To use more than one repeated

capability in one attribute separate them with a comma.

See a marker example using repeated capabilities pictured in the following figure:
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How to use attributes in LabWindows/CVI?

B! Configure rsspecan_core_attribute_express [Set Marker Sk @l ll

Select Attribute Attribute ID
«|[RSSPECAN_ATTR_MARKER_EMABLED

Basic Operation Attribute Help
Markers

This attribute switches on or of f the currently d
selected marker in the selected measurement
window, If no indication is made, marker 1 is
selected aukomatically, IF marker 2, 3 or 4 is

....... Assign Marker ta Trace selected and used as a delta marker, it is
_______ &l Markers CFF switched to marker mode,
Marker Local Oscillatar Suppression avallable Repeated Capabilties:
------- Signal Track State ‘Windowe: Wind, Winl, Win2
....... Signal Track Bandwidth Marker: M1,MZ,M3, M4

------- Signal Track Threshold

iy ‘ Remote-control commandis):
------- Signal Track Trace CALCulate<1|2=MARKer <1 to 4=[:5TATe]
------- Marker Step Size

------- Marker Probability
------- Marker Receiver Frequency Coupling
------- Marker Subscan Coupling

[ Marker Search
[ Marker Search Configuration
[ Marker Functions
[ Delka Matker -
T _>l_I L
Attribute Operation Repeated Capabilities Input Boolean
itk -] |m1, mz (
| =l o, U oN

OF I Cancel Help

Figure 19: Example for "Repeated Capabilities"

The attribute and its features can be changed any time later by double clicking the VI,
which recalls the shown Express Vls front panel.

4.6 How to use attributes in LabWindows/CVI?

The following example is referring to the RsSpecAn instrument driver. The described
procedures are all adaptable to other attribute based R&S instrument drivers, only the
naming of the files can be different. The naming convention is rsXXX, where XXX is
the abbreviation of the instrument's (-family) driver.

The following chapter shows how to use attributes in the RsSpecAn driver. This is only
necessary in rare cases, for instance if the driver is not supporting the functionality via
high level API.

Please use the Driver Attribute Help chm file. This help file is accessible via the
Instruments Driver Help (rsXXX[_vxi].chm).

Note: The rsspecan.sub file has to be added to the project. This is mandatory for
browsing attributes.

Example: How to set the Frequency Start value by attributes
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How to use attributes in LabWindows/CVI?

To select an attribute use the provided function panels, included in instrument driver
package. This instrument driver function panels can be found in:
Instruments=>R&S SpecAn=>Configuration=>Set/Get/Check Attribute/Repeated
Capabilities

#03 Libraries
1D Imstuments

= jﬂ RohdekSchwarz Spectum Analyzer
rEzpecan_init
rezpecan_|nitwith ptions
58] respecan_SetSAMMode

rszpecan_ConfigureFrequencyStantStop

rszpecan_ConfigureFrequencyCenter

rezpecan_ConfigureFrequencyCenterSpar

@ Transducer
@ Hardoopy
@ Calibration
@ User Port
- Set/Get/Check Atribute
-
B rzspecan_5etdtibutelilnt32
rezpecan_SetdtnbuteiRealb4
rezpecan_S etdttibuteliSting
rezpecan_SetdtibuteViBoolean
rezpecan_S etdttibuteiS ession
+-4 Get Attibute
+-4 Check Attibute
+- 4 Repeated Capability

Dol WAoo L

4
4
4
4

Figure 20: Function panel for RsSpecAn driver attributes

To open the function panel double click on the desired function. In the figure below the
function panel of "rsspecan_SetAttributeViReal64" is pictured. By clicking on text box
"Attribute ID" the "Select Attribute Constant" window will be opened.

Now it is possible to select the desired attribute from tree structured list. Each attribute
can have different access type (read only, write only or read/write). Proper read/write
operation can be selected by the proper function panel, either Set Attribute, Get
Attribute, or Check Attribute.

Repeated capabilities are set by using identifier or identifier names within the function
panel called rsspecan_GetAttributeRepeatedCapabilityld[s|Names].

For example use in Basic Operation "Set Frequency Start" value:
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How to use attributes in LabWindows/CVI?

5/%) Untitled Al Unfiledl e | SetéltibuteViReald
&

rspecan_athibutes.c

sspecan_calbacks.c Repeated Capability Mame: Attribute 1D
sspecan_ulilit.c ] Attenuation
E L]
E1ES Include Files
tsidr_core.h
Eh| rsspecanh — Attributs Yalue
Fal reenaran athiknbas ki
s ] Hribuibas b LIJ ] I:l
4y Marker A
+-4 Delts Marker
44 System
+4 Trigger
s Gate
+4 Extenal Mixer Extension Group
o Amplitude: Status
4@ Limit Lines Instrument Handle
4y Display Control 1 ’:’
+ 4 Transdueer
1St x
63 User Port
= g Set/Get/Check Atirbute Daispe: Sl o pes
=% Sel Attibute o Adtibutes:
rsspecan | iInt32
& Inherent Instrument Specilic Atiibutes... s oK I
specan_Setbttibutey/iSting #- Inherent Yendor Specific Attributes
specan_SetitributeViBoolean £ Basic Dperation... j
rsspecan_SetttributeViS ession Amplitude Units
= @ Get Attibule Attenuation Vieali
-4y Check Attibute Attenuation duto
- Fiepeated Capabilty ViRealbd
® Measurement Frequency Stop ViRealGd
@ Feceiver Frequency Diffset ViRealbd
@ Tracking Generator Center Frequency iRealE4
4 B27 - FM Damodulation Anslog Center Frequency Step ViFealsd
4 E71 - Analog Baseband Input Center Frequency Step Auta
4 B17- Digital Baseband Input Ceriter Fraquency Coupling
@ K5-GSM/EDGE M5/B5 Test Center Frequency Coupling Factar
@ K7 - Analog Demodulator Frequency Span ViReal6d x| T Flatten
4 K& - Bluetooth Snalyzer
4 K9 - Power Meter Altribute help:

@ K14 Spectrogram M )

& K15 - Aviorics Measurement Data Type: ViReslod

@ K20-Cable TV Analzer Description: Specifies the left edge of the freguency domain in Hertz. This is used in conjunction with the

® K30 Noise Figue and Gain Measuement | |pespECAN_ATTR_FREQUENCY_STOP Stop atirioute to define the frequency domain, Ifthe

@ Kil-Phase Noise ) RSSPECAN_ATTR_FREQUENCY_START atiibute value is equal to the

: K70 - Vector Signal Analysis .| |RSSPECAN_ATTR_FREQUENCY_STOP attribute value then the spectrum analyzers horizontal attributes are in

K72/74 3GPP FDD Base Station Test fime-damain,

4 K73-3GFF FDD UE Measuements ﬂ

& K76-TD-SCOMA BTS Mode

& K77 - TD-5COMA MS Mode E ; W
thttributeViRealed (. . RSSPECAN_ATTE_ATTENUATION, ):

4 CDMAZ000 Common Settings FeSpenan_se FriMietLEes. ¢ - - !

. i 7
. 4 K82 - COMA2000 Base Station TTsl Ly

Constant. RESPECAN_ATTR_FREQUENCY_START j

AEREREDEEDEEAEEAEEEEEEEEE

Figure 21: How to select a attribute in the "SetAttributeViReal64" function panel

1. Please select the desired attribute. To find the designated attribute easily the

rsspecan.chm help file can be used to look for it. Be aware of the fact that the tree

structures in the help file and the Express VI are the same

Leave "Repeated Capabilities" string empty

Type the desired frequency value in the text box "Attribute Value", e.g. "1e+9"

Enter a valid instrument handle in the text box "Instrument Handle"

It is strongly recommended to fetch the return value of your function, if you type the

name of a declared integer variable in the text box "Status"

6. To include the function into your source code, you can copy the created function
string out of the window on the button of the function panel and insert it into the
source code.

abrwd

The result is shown in following figure.

respecan_SethttributeViRealed (instrSession. "". RSSPECAN ATTE FREQUEHCY START. le+9):

=

Figure 22: Build a function string on the button of the "rsspecan_SetAttributeViReal64" function
panel
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How to use attributes in LabWindows/CVI?

The attribute and its features can be changed any time later by right clicking the
function and recall the function panel. See picture below:

3 rezspecan_SefdttributeViRealfd (instrSession, ", RSSPECAN ATTR_FREQUENCY_START. 1=+
4 Recall Function Panel Chrl+P |

Browse Identifier Ckrl+F1

Find LI Object Chrl+Shift+L

Cpen Quoked Text Chrl+U

= b MiaFinikinn helT

Figure 23: Recalling the function panel to modify the attributes

4.6.1 Repeated capabilities
Many instruments have capabilities which are duplicated. For example, an oscilloscope
might have several channels with identical functionality or a power supply may have
several outputs. For this reason repeated capabilities are introduced.
Repeated capability instances are specified by a string parameter for each property.
To define the usage of particular capability fill the text box "Repeated Capability Id" in
the front panel with the proper value. To use more than one repeated capability in one
attribute separate them with a comma.
See a marker example using repeated capabilities pictured in the following figure:
5le) Untitled Al Uniiledl.e | Setbibuel e | GellibucRepesedapabiiylds | GetAtiibuteRepss. Capsbiltdismes | x
=1 Source Files
3 =i
fer] 1sspecan atributes.c ki
fum — " Jj Attrbute 1D Fiepeated Capabilty 1d Buifer Size:
: ?;:ﬂ:;uﬂc:tml ﬂMameu State ] sz 1256
B Hardeopy
B Calibration »
b User Poit Riepeated Capabiity 1d Namels)
i Set/Get/Chack Attribute l&nyViCharString [ NUM_OF_REP_CAP]
B Set Atiribute |
specan_Sethtributetilnta2
specan_SetatiibuteviRealE4
specan_SetitibuteViSting J
specan_SetitributeViB oolean
[58] respecan_SetbthibuteVis ession
-4 Get Attribute = Status
@ Check Attribute Instrument Handle:
& Repeated Capabilty —
B rsspecan GetattributeRepsstedCapatilitylds instrisssion
isspecan_GetdttibuteRepeatedCapabilityldN ames
easurement status - resspecan_GetittributeRepeatedCapabilityldNames (instrSession, . . j
Seceiver RSSPECAN_ATTR_MARKER_ENAELED. "M1.H2",
o I»Iﬂ B 256, &myWiCharString[NUM_OF_REP _CAP]): A
Figure 24: Example for "Repeated Capabilities" in LabWindows/CVI
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4.7 How to use attributes in Agilent VEE?

Due to the fact that Agilent VEE® does not parse the sub-file corresponding to the
VXIPnP standard, there is only the possibility to look for the corresponding attributes®
in the rsspecan_attr.chm file and use the Rohde&Schwarz Spectrum Analyzer->
Configuration -> Get/Set/CheckAttribute function set.

® Tested with Agilent VEE Pro 9.0, see
http://www.home.agilent.com/agilent/product.jspx?nid=-
34095.806312.00&cc=US&Ic=eng

® The following is referring to the RsSpecAn instrument driver. The described
procedures are all adaptable to other attribute based R&S instrument drivers, only the
naming of the files can be different. The naming convention is rsXXX, where XXX is
the abbreviation of the instrument's (-family) driver.
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How to run a scan measurement with the R&S®ESL EMI Test Receiver and the RsSpecAn instrument driver?

5 RsSpecAn specific hints

5.1 How to run a scan measurement with the R&S®ESL
EMI Test Receiver and the RsSpecAn instrument
driver?

Please find necessary commands the rsspecan_vxi.chm help file. Crucial for a
continuous reading of the scan trace is following function:

rsspecan_ConfigureReceiverTraceFeedControl
(instrSession, RSSPECAN_VAL_TRAC_FEED_ALWAYS);

For LabVIEW applications the command is called

rsspecan Configure Receiver Trace Feed Control.vi

For further information please have a look at the scan measurement example
application on the instrument'’s driver download site.
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Supported distributions

6 Linux Instrument drivers

Due to the fact that the Linux as desktop operating system is becoming more and more
popular Rohde & Schwarz supports instrument drivers for Linux distributions.

The aim of the this chapters is to give a brief overview of how to get started with R&S
instruments drivers on a Linux operating system.

6.1 Supported distributions

Rohde & Schwarz instrument drivers are build up on the VISA standard and thereafter
they are compatible to the ANSI-C99 standard’. National Instruments VISA installation
package, which is crucial for using Rohde & Schwarz instrument drivers, is currently
suppor’ting8 following distributions:

e Mandriva Linux 2008 and Mandriva Linux 2009
e 0penSUSE 10.3 and openSUSE 11.0

Rohde & Schwarz supports these distributions as well.

6.2 How to view "Compressed HTLM Help Files" (chm)
in Linux

On Linux operating systems many viewers for Compressed HTML Help files available,
for instance:

KDE desktop environment:
In the KDE environment the kchmviewer® is available.

" For futher information please visit http://www.open-
std.org/JTC1/SC22/WG14/www/docs/n1256.pdf

8 For latest updates please visit http://www.ni.com/visa/
® Available under http://www.kchmviewer.net/
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How to install R&S instruments driver?

6.3 How to install R&S instruments driver?

Getting started with LabVIEW 7 or higher:
Please be aware of the fact that for various instruments dll-based instrument driver are
available (a), otherwise native LabVIEW driver are provided (b).

a. For dll-based VXIPnP instrument driver please download the rsXXX-linux-
xxx.tar.gz and the rsXXX-linux-lvx-xxx.tar.gz from the instrument's download
site. Extract the tar files and follow the instructions of the README file.

b. For native LabVIEW drivers it is only necessary to download the rsXXX-linux-
Ivx-xxx.tar.gz file. Thereafter extract the tar file and follow the instructions of
the README file.

Getting started with C/C++:
Visit your instrument's driver site to download the rsXXX-linux-xxx.tar.gz (Linux
Instrument Driver) tar file. Thereafter extract the tar file and follow the instructions of

the README file.
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Resources

How to install R&S instruments driver?

[ Resources

e Rohde & Schwarz Driver download site http://www2.rohde-
schwarz.com/en/service_and_support/Downloads/Drivers
National Instruments VISA: http://www.ni.com/visa/

National Instruments LabVIEW: http://www.ni.com/labview/
National Instruments LabWindows/CVI: http://www.ni.com/Iwcvi/
Agilent VEE: www.agilent.com/find/vee

IVl Foundation: http://www.ivifoundation.org/

Accessed: 05/27/2009
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About Rohde & Schwarz

Rohde & Schwarz is an independent group
of companies specializing in electronics. It is
a leading supplier of solutions in the fields of
test and measurement, broadcasting, radio
monitoring and radiolocation, as well as
secure communications. Established 75
years ago, Rohde & Schwarz has a global
presence and a dedicated service network
in over 70 countries. Company headquarters
are in Munich, Germany.

Regional contact

Europe, Africa, Middle East

+49 1805 12 42 42* or +49 89 4129 137 74
customersupport@rohde-schwarz.com

North America
1-888-TEST-RSA (1-888-837-8772)
customer.support@rsa.rohde-schwarz.com

Latin America
+1-410-910-7988
customersupport.la@rohde-schwarz.com

Asia/Pacific
+65 65 13 04 88
customersupport.asia@rohde-schwarz.com

Certified Quality System

ISO 9001

DQS REG. NO 1954 QM

Certified Environmental System

ISO 14001

DQS REG. NO 1954 UM

This document and the supplied
programs may only be used subject to the
conditions of use set forth in the download
area of the Rohde & Schwarz website.
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